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Microsoft Outlook 2007 — Effective Email Inbox Organization

I. Tools to Manage Current Messages

Page 1

Current messages are email messages in your Inbox that you need to do

something about. This may be as simple as reading and filing, or reading and

deleting. However, most messages require you to perform an action, whether to

reply with information or to perform a task and then reply.

The following features help you keep track of what messages require a follow

up, how to keep track of due dates, and how to find follow up messages.

A. Using Flags with Due Dates for Follow Up

If a message requires a follow up action,

. ) =i Bill Ramirez Tue 2/5 =
set a follow up flag on it. This marks the RE: Custom o emyX - 2 stude...
. -1 Bill Ramirez — Tue 2/5
message and places the message in the ot &% print P
To-Do list under Tasks. "1 Eddie Barlow [ Reply Mon 2/4
RE: Sign-ups _&\‘ Reply to All 27403
. . | L1 Bill Ramirez | . r d Mon 2/4
1. Inyour Inbox, right-click the message RE: Handout] " FOMar
i Follow U
that you want to flag for a follow up. ||~ fdieBaroy, - To8HP ¥ Iody
Htertne Categorize \” Temorrow
] Bill Ramil .
2. Select Follow Up - (due date for RE: Dt e L3 Mark as Unread \ This Week
follow_up)' 1 [ Bill Ramirez Find All " Next Week
[' RE: Dreamwsg [ Create Rule. ¥ NoDate
= Eddie Barlow Junk E-mail ‘f’ Custom...
RE: Follow u
| 3 eddie Bariow X Delete 4 Add Reminder...
RE: Follow u -.j Move to Folder... " Mark Complete
] &4 badse Barion 2] Message Options... Clear Flag
1| =] Stephen Fra rg_: Send to OnefNote Set Quick Click...
BF: Tnunira far [ata Tannanr wnrk a
[ )

To select a follow up flag quickly, right-click the flag icon and select your

desired flag.
"] Bill Ramirez 1/21/2008 |
| Checking in Y’ Today
.| Bill Ramirez 1/18/2008 ¥ Tomorrowfs,
Dreamweaver info on UC Berkeley ) -
-1 Bill Ramirez 1/18/2008 N\ This Week
Dreamweaver web site class N Mext Week
-] Eddie Barlow 1/16/2008 ¥ Mo Date
RE: Schedule UCOP Change
¥ Custom...
| Eddie Barlow 1/16/2008
Schedule UCOP Change A Add Reminder...
-] Eddie Barlow 1/16/2008 " Mark Complete
RE: Confirming Training dates that we discussed yesterday o
-1 Bill Ramirez 1/16/2008 I
RE: FW: Access Training 1/24 - 1/25 Set Quick Click...
-
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e While viewing the message, click Follow Up in the Ribbon and select the
Due Date.

. » VI o - 4 Find
1 i = x 1 e % Safe Lists
« « = -l s i 3, Related
Reply Reply Forward | Delete Moveto Create Other Block Mot Junk
to Al Folder~ Rule Actions~ || Sender kg Select -
Respond Actions Junk E-mail P Find

e You can set a reminder for the follow up by right-clicking the message
and selecting Follow Up > Add o e ==
Reminder... In the Custom dlalog Flagging creates a to-do item that reminds you to follow up. After you
follow up, you can mark the to-do item complete.
box, click the Reminder checkbox

? Flag to: Follow up lz‘
and select the date and time that R enay, Februmry €5, 2008 =]
you want to be reminded. o C———— =

Reminder: \

Tuesday, February 12,2008 | ~| [12:00PM [=] [a¢
Clear Flag . Cancel I
¢ You can specify the type of To- Custom 7 =]
: : _li 3 Flagging creates a to-do item that reminds you to follow up. After you
dO action by rlght Cthlng the follow up, you can mark the to-do item complete.
message and selecting Follow Up ? Fagto: |E =
1 call -
- Custom. In the Custom dialog stortdare: [ s
. _ Follow up E
bOX/ use the Flag to: drop down Due date:  |For Your Information
- Forward
to select a type of To-do action. [ Reminder: No Response Necessary

i
1
1T
n
5
i
il
i
(il
v
L
%}
G
;T\| A

Clear Flag [ (6]4 l I Cancel

e When you have followed up with the message, mark it as complete by
right-clicking the message and selecting Follow Up - Mark Complete. Or,
click the flag icon in the message list to change it to a check mark.

Tasks « || ¥ To-DoList
B. Managing Flagged Messages in Tasks Barmatms - [[Saowoo 2]
My Tasks 2 *|| Arranged By: Due Date Today on top |
All email messages which have been flagged T
. . . Current View % = ¥ Toda
for fOIIOW-up are IISted ]'n the TO-DO IISt under ) Simple List J_{ Custom ‘.Y".‘urd&PPTZUGB,FEDIS at Academyk - 2 st... Y
o Detailed List -] Follow up on Intermediate Excel at UCOP today 1/2. A\ d
Tasks. etsomonn | || Tomorow
Overdue Tasks —|l| £ sign-ups for Excel Adv dass at UCOP on 2/4/08 \'d
You can reply to, delete, or mark as complete o [La
By Persan Responsibl| || 3 DWwebsite handouts update X
directly from the To-Do list by right-clicking N Carticinic
the message and selecting the appropriate i A
& To-Do List 8 | B
command. —— )
[~ Mail
757 catendar
LE| Cong
< /] Tasks >
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C. Creating a Follow Up Search Folder

Page 3

The Search Folders let you create separate lists of messages that meet certain

criteria.

1. Go to your Mail area in the left navigation list.

2. In the Mail Folders list, right-click Search Folders
and select New Search Folder...

3. In the New Search Folder dialog box, select
Mail flagged for follow up. Click OK.

4. Click the For Follow Up folder under Search

Folders to view a list of all messages flagged
for follow-up.

Mail Folders
2] All Mail Items

E] t:—& Personal Folders
fa] Deleted Items (1)
Lz# Drafts
= [ Inbox (20
[ AcademyX
[ Test Items
3 uce
1 Junk E-mail
=] Outbox

»

Mail Folders
2] All Mail Items

»

=] ‘E‘-ﬁ Personal Folders
() Deleted Items (1)
L2#| Drafts
= L] Inbox (20}
| Academyx
| Test Items

- Yahoo!
Message From Yahao
~1 Mishikai Test

-~ Bill Ramirez
RE: Custom Word &
=] Bill Ramirez
Custom Word & PPT

[ UCB
1 Junk E-mail

| Eddie Barlow
RE: Sign-ups for Exo

L4 Cutbox
[ Quarantine
L R55 Feeds

] Bill Ram

irez

ems (22)

Enldarc

3 O Search

Ll Mew Search Folder... h
3
Process All Marked Headers

Mew Search Folder
Select a Search Folder:
Reading Mail

Urread mail

i Mail flagged for follow up

Important mail

Mail from People and Lists
Mail from and to spedific people
Mail from spedific people
Mail sent directly to me

Mail sent to distribution lists
Organizing Mail

Customize Search Folder:

Search mail in: | Personal Folders

Mail either unread or flagged for follow up o

[ Quarantine

L R55 Feeds

=l L& Search Folders
L2 For Follow Up

* You can create other Search Folders in the New Search Folder dialog box,
such as for Unread mail or Mail to and from specific people. These are all
filtered lists which display only the messages which meet those
requirements.

L]

“(name of search folder)”.

To remove a Search Folder, right-click the folder name and select Delete

© 2008 Nishikai Consulting. All rights reserved.
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D. Using Colors to Categorize
You can also categorize messages with colors and category names.
. . _-| Eddie Barlow Maon 2/4 3
1. In your Inbox, right-click the R Gpen COP on 2/4/08
= il - Mon 2/4
message that you want to color. S & print e
. r & Repl
2. Select Categorize < (color = bad e SV 22008
Outl =% Reply to All
category). B o Fonward B O
1 Bin Follow Up 1/30/2008
RE: Categorize Clear All Categories
- ::d =0 Mark as Read L@ Create Category Search Folder...
-1 Edd Find Al C] Blue Category
RE: & Create Rule... E] Green Category M
- - ¥
S Junk E-mail [[] Orange Category
1 Stey X Delete L) Purple Category
RE:| 23 Move to Folder... L) Red Category
- IBT :] Message Options... C] Yellow Category
ntr
1 Bin @: Send to OneMote ED All Categories...
Checking in Set Quick Click...

3. The message will be marked with a color square next to the follow-up flag.

= Eddie Barlow

Mon 2

RE: Sign-ups for Excel Adv class at UCOP on 2/4/08

e If this is the first time you are using this  grremmr R
Category COIOI', a dlalog bOX WIH Open This is the first ime you have used "Blue Category.” Do you want to
k. f t t th rename it?
asking if you want to rename the Nome: | Green Categary
category. Enter a name if desired, and Color: Shortcut Key:
click Yes. Or, click No to keep the e [ v ]
original name.
e To select a category quickly, right-click the color square icon and select
your desired category.
- Bill Ramirez 1/21/2008 A
Checking in Clear All Categories
-] Bill Ramirez 1/18/2008
Dreamweaver info on UC Berkeley LA  Create Category Search Folder...
-1 Bill Ramirez 1/18/2008 | (L] Blue Category
Dreamweaver web site class [:] Green Category
| Eddie Barlow 1/16/2008 D Red Catedo [}
RE: Schedule UCOP Change gory
-1 Eddie Barlow 1/16,2008 C] Orange Category
Schedule UCOP Change D Purple Category
-] Eddie Barlow 1/16/2008 [:] Yellow Category
RE: Confirming Training dates that we discussed yesterday 0 .
<1 Bill Ramirez 1672008 | o Al Categories...
RE: FW: Access Training 1/24 - 1/25 Set Quick Click...
© 2008 Nishikai Consulting. All rights reserved. hn 02/2008
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Page 5

While viewing the message, click Categorize in the Ribbon and select a

category color.

. 3 5
_ﬁl' _ﬁk'] _‘;é x —J ._:.r'r

Reply Reply Forward | Delete Moveto Create Other Block
to All Folder~ Rule Acions~ || Sender
Respond Actions Junk E-mail

% &, safe Lists ~

ollow Mark as
Up~ Unread

34 Find
2 Related -

Lg Select -

Find

To remove a category color, right-click the message and select Categorize >

Clear All Categories. Or, click the color square in the message list.

To rename, delete, or
create new color
categories, right-click any

message and select
Categorize -2 All

Categories... Click New to
create a new category.
Select the category and
click Rename to rename it.
Select the category and
click Delete to delete it.

E. Viewing By Category

Once messages have been categorized, you can sort

Color Categories

Lo =

To assign Color Categories to the currently selected items, use the checkboxes next to each
category. To edit a category, select the category name and use the commands to the right.

messages according to that categorization.

1. Right-click the Arrange By bar.

If you do not see the Arrange By bar, go to View >

Arrange By.

2. Select Categories.

To show in groups, right-click the Arrange By bar

and select Show in Groups.

You can select other arrangements using the
Arrange By bar, such as sorting by From or Subject.

~i Mishikai Test
Test Message 1

—1 Bill Ramirez
Custom Word

] Eddie Barlow
RE: Sign-ups fi

1 Bill Ramirez
RE: Handouts

| Eddie Barlow
Ot of the Off

~J Bill Ramirez
RE: DW websit

-] Bill Ramirez
RE: Dreamwea

-] Eddie Barlow

Shortcut key Mew...
__F‘.ename
[C1[Z) Green Category
[C11@) Purple Category Color:
08 rescar
Yellow Category
EE Shartout Key:
OK. ] [ Cancel
L3 In Search
< Arranged By: Date
Microsoft Offig Conversation
-1 Yahoo! Erom
Message From To

Categories L}
Flag: Start Date
Flag: Due Date
Size

Subject

Type
Attachments
E-mail Account
Importance
Custom...

Show in Groups

© 2008 Nishikai Consulting. All rights reserved.
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F. Adding View Filters

Page 6

View Filters let you filter your current view, such as your Inbox or Sent Items
folder, so that you only see a subset of messages. This is helpful for temporarily

focusing on that subset of messages.

1. Go to View > Arrange By = Custom.

e Or, right-click the Arrange By bar and select Custom.
e Or, g0 to View - Current View - Customize Current View.

2. In the Customize View dialog
box, click Filter...

Customize View: Messages

Description

7 =]

Importance, Reminder, Icon, Flag Status, Attachment, Fro...

.|

3. In the Filter dialog box, enter the
criteria for the filter. For example,
search for the words “ABC Project” to
view only the messages which contain
those words.

4. Click oK.

I Group By... ‘ Moneg
I Sort... ‘ Received (descending)
Filter... ff
I Other Settings... ‘ Fonts and other Table View settings
I Automatic Formatting. .. ‘ User defined fonts on each message
I Format Columns... I Spedfy the display formats for each field
I Reset Current View I Ok I I Cancel I
Filter (-7 |[ma]
Messages |More Choices | Advanced | SqQL |
Search for the word(s): |Z|
In: |subject field only |Z|
Sent Tou..
[F] where 1 am: the only person on the To line
Time: |none IE‘ anytime
OK J [ Cancel J [ Clear Al

e To remove the filter, go back to the Filter dialog box and click Clear All.

© 2008 Nishikai Consulting. All rights reserved.
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G. Managing Current Views

Page 7

If you want to use a certain view often, such as a filtered view, you can save that

view in the Current Views list.

Outlook contains a list of predefined Current Views. Go to View - Current View >
(select a view). Or, turn on the Advanced toolbar and select a view from the
Current View drop-down.

To create your own custom view:

Bat | @Back @ A |H (&

P> =LLY

1. GO to View = Current Views 2> Custom View Organizer -5 |3l
Define Views... Views for folder "Inbox™
L OI', select Define Views... View Name Can Be Used On View Type | « Newss
f h C V <Current view settings > All Mzil and Post folders | Table
rom the Current View Messages All Mail and Post folders  |Table l Copy
s Messages with AutoPreview All Mail and Post folders  |Table ———
drop-down in the i
p Last Seven Days All Mail and Post folders  |Table E M
Advanced tOOlbar. Unread Messages in This Folder | All Mail and Post folders [ Table T
Sent To All Mail and Post folders |Table
2 In the Custom VleW Message Timeline All Mail and Post folders | Timeline Reset
: Outlock Data Files All Mail and Post folders | Table
Organizer, CliCk New ... Documents All Mail and Post folders  |Table hd
Description
Fields: Importance, Reminder, Icon, Attachment, From, Subject, Received, Size, Categ

Group By: Arrangement Label (descending)
Sort: Received (descending)

Filter: Off

[~] Only show views created for this folder

Create a New View

3. Inthe Create a New View dialog box, enter the
name of the new view. Select a type of view, and
where this view can be used. Click OK.

Name of new view:
My Filtered View
Type of view:
Table

Timeline

Card

Business Card

Day/WeekManth
Icon

Can be used on

@) This folder, visible to everyone
_ This folder, visible only to me

~ All Mail and Post folders

L7 =]

[ OK l I Cancel

)

© 2008 Nishikai Consulting. All rights reserved. hn 02/2008
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4. In the Customize View dialog box, set the options for your view. For
example, click Filter... and set a filter criteria. Then, click OK.

. . . Customize View: My Filtered View 7=
5. Click Close to exit the Custom View S
Organizer Importance, Reminder, Icon, Flag Status, Attachment, Fro...

Group By... Mone
Sort... Received (descending)
Filter... Off
Other Settings... Fonts and other Table View settings
Automatic Formatting... | User defined fonts on each message
Format Columns... Spedify the display formats for each field

Reset Current View oK Cancel

H. Dragging Emails to Calendar/Tasks/Contacts

If you want to add information from a message to a new appointment, task, or
contact, simply drag the message from the Inbox list to Calendar, Tasks, or
Contacts in the left navigation.

e When you drag a message to Calendar, a new appointment window appears
with the Subject and text of the message. Select your appointment date and
time, and click Save.

Subject: Test Message 1

Location:

Start time: | Fri 2/15/2008 E 9:30 AM [=] [C]an day event
Endtime: | Fri 2/15/2008 [=] [1000am  [+]

e When you drag a message to Tasks, a new To-Do window appears with the
Subject and text of the message. Select your To-Do options and click Save.

Subject: Test Message 1

Start date; | None [=] status: [motstarted

Due date: Hone B Priority: | Mormal [+] secomplete: 0% 2
7| Reminder: | Mone :‘ Mone Owner: | Nishikai Test

|
¢ When you drag a message to Contacts, a new Contact window appears with

the Name and E-mail address of the sender. Enter any additional data and

click Save.
Nishikai Test

Company: 6
Job title: <

File as: Test, Nishikai
Internet

B test@nishikai.com

Display as: Hishikai Test

Web page address:
IM address:

© 2008 Nishikai Consulting. All rights reserved. hn 02/2008



Microsoft Outlook 2007 — Effective Email Inbox Organization Page 9

II. Tools to Manage New Messages
There are several tools that will let you manage new, incoming messages more
efficiently.

The following features help you flag and categorize messages quickly as well as
create rules to automate actions as messages arrive.

A. Setting Quick Click for Follow Up
The Quick Click for Follow Up setting lets you select a default Due By date.

1. Right-click on any message and select Follow Up > (et Quicl; Click R

Set Quick Click...
Q When single-dicking on the Flags

2. In the Set Quick Click dialog box, select the Due By L IpTLL LR IO
flag that you want to be the default choice. Click OK. v ¥ Today E2

[ Ok ]I Cancel I

3. To use the Quick Click, click the flag icon in an unflagged message to set the
default flag.

~i Bill Ramirez 1,20,/2008
RE: Dreamweaver web site class Y}

B. Setting Quick Click for Categorize
The Quick Click for Categorize setting lets you select a default category.

1. Right-click on any message and select Categorize | et Quick Click (-2 |l
- Set Quick Click...
2. In the Set Quick Click dialog box, select the

=
category that you want to be the default choice. | | | I
Click OK.

When single-dicking on the Categories
column, add the following category:

Red Category "I

[ Ok ]I Cancel I

3. To use the Quick Click, click the color square icon in an uncategorized

message to set the default flag.
=i Bill Ramirez 1_;30;2

© 2008 Nishikai Consulting. All rights reserved. hn 02/2008
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C. Creating a Rule from Scratch

Rules let you automate actions, such as moving a message from a specific person

into a specific folder.

1. While viewing your Mail, go to Tools - Rules and Alerts.

2. In the Rules and Rules and Alerts =
Alerts dialog box, [ E-mail Rules. | Manage Alerts
CliCk New Rule... fj Mew Rule... Change Rule » 53 Copy... >( Delete Run Rules Mow... Options
Rule {(applied in the order shown) Actions
Clear categories on mail {recommended) f&"

Rule description (dick an underlined value to edit):

Apply this rule after the message arrives
assigned to any category
clear message's categories

[T]Enable rules on all R55 Feeds

OK ][ Cancel ] Apply

3. In the Rules Wizard dialog box for
“Starting from a template or from a
blank rule”, select the type of action
that you want to perform. Click
Next.

Rules Wizard

Start from a template or from a blank rule
Step 1: Select a template
Stay Organized
i ™ Move messages from someone to a folder
_3 Move messages with specific words in the subject to a folder
5 Move messages sent to a distribution list to & folder
>( Delete a conversation
Y’ Flag messages from someone for follow-up
_3 Move Microsaft Office InfoPath forms of a spedific type to a folder
™3 Move RS5 items from a spedfic RSS Feed to a folder
Stay Up to Date
<. Display mail from someone in the New Ttem Alert Window
ifl Play a sound when I get messages from someone
'Q Send an alert to my mobile device when I get messages from someane
Start from a blank rule
- Check messages when they arrive
=1 Check messages after sending

Step 2: Edit the rule description {dick an underlined valus)
Apply this rule after the message arrives

from pecple or distribution list
move it to the spedfied folder

Example: Move mail from my manager to my High Importance folder

< Back [ Next = l[ Finish

© 2008 Nishikai Consulting. All rights reserved.
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4. In Step 1 of the Rules Wizard
dialog box for “Which conditions do
you want to check?”, select the types
of conditions that you want to
meet.

Page 11

Rules Wizard

Which condition(s) do you want to chedk?
Step 1: Select condition(s)

from people or distribution list

[] with specific words in the subject

[] through the spedfied account

[ sent only to me

[[] where my name is in the To box

[] marked as importance

[] marked as sensitivity

[] flagged for action

[] where my name is in the Cc box

[] where my name is in the To or Cc box

[] where my name is not in the To box

[] sent to people or distribution list

[] with specific words in the body

[] with spedific words in the subject or body
[] with spedfic words in the message header
[] with specific words in the recipient's address
[] with spedfic words in the sender's address
[] assigned to cateqory category

Step 2: Edit the rule description {dick an underlined value)

Apply this rule after the message arrives

from pecple or distribution list
move it to the spedified folder

»

m

Cancel

J |

< Back ][ Next = ][

Finish |

5. In Step 2, click the type
of condition to specify
the exact conditions. For

Rule Address

Search: @ Mame only

(1 More columns Address Book

Go Contacts

B3

- Advanced Find

example, if you clicked

Display Mame

E-mail Address

“people or distribution
list”, the Rule Address
dialog box will appear.
Double-click the name
of the person or
distribution list so that
it appears in the From
field, then click OK.

Bill Ramirez

Eddie Barlow

4

L1

Bill Ramirez

J [ Cancel

6. In the Rules Wizard dialog box, click Next.

© 2008 Nishikai Consulting. All rights reserved.
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Page 12

Rules Wizard

7. In Step 1 of the Rules Wizard
dialog box for “What do you want to

What do you want to do with the message?
Step 1: Select action(s)

do with the message?”, select the

‘mave it to the specfied folder

actions that you want to have
performed.

[] delete it

[ printit
[ play a sound

[ run & script

[] start application
[] mark it as read

[] assign it to the category category

[ permanently delete it

[] move a copy to the specified folder
[] forward it to people or distribution list
[] forward it to people or distribution list as an attachment
[ reply using a specific template

[] flag message for follow up at this time
[] dear the Message Flag

[[] dear message's categories

[] mark it as importance

[7] stop processing more rules

Step 2: Edit the rule description {dick an underlined value)
Apply this rule after the message arrives
from Bill Ramirez

and on this machine only
move it to the spedfied folder

m

Cancel ][ < Back ][ Next =

| [ Finish

8. In Step 2, click the type of action to specify
the exact action. For example, if you clicked

-
Rules and Alerts

Choose a folder:

d

“specified folder”, the Rules and Alerts dialog
box will appear. Select the folder that you
want to move these message to, then click
OK.

= t:{,ﬁ Personal Folders

tﬁ Calendar

8 Contacts

fa] Deleted Items (1)

L&A Drafts

= L) Inbox (13)

) AcademyX
[ Test Items
3 ucCe

53 Journal

L @ Junk E-mail

= | Motes

L= Outbox

Cancel

Ik

m

9. In the Rules Wizard dialog box, click Next.

© 2008 Nishikai Consulting. All rights reserved.
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10. In Step 1 of the Rules Wizard

dialog box for “Are there any

exceptions?”, select any exceptions.

11. In Step 2, click the exception. For

example, if you clicked “specific
words”, the Search Text dialog box
will appear. Enter the words to

search for in the subject, then click
OK.

Microsoft Outlook 2007 — Effective Email Inbox Organization

Page 13

Rules Wizard

Are there any exceptions?
Step 1: Select exception(s) (if necessary)

[] except if from people or distribution list

except if the subject contains spedific words

[] except through the specified account

[] except if sent only to me

[] except where my name is in the To box

[] except ifitis marked as importance

[] exceptifitis marked as sensitivity

[] exceptifitis flagged for action

[] except where my name is in the Cc box

[] except if my name is in the To or Cc box

[] except where my name is not in the To box

[] except if sent to people or distribution list

[] except if the body contains specific words

[] except if the subject or body contains spedific words
[] except if the message header contains specific words
[] except with specific words in the redpient's address
[ except with specific words in the sender's address
[] except if assigned to cateqory category

Step 2: Edit the rule description {dick an underlined value)
Apply this rule after the message arrives
from Bill Ramirez
and on this machine only
move it to the Academyy folder
except if the subject containsispedific words:

m

Cancel ][ < Back " Next =

| [ Fnish |

Search Text

Spedify words or phrases to search for in the subject:
Ucor|

Search list:

Cancel

12. In the Rules Wizard dialog box, click Next.

© 2008 Nishikai Consulting. All rights reserved.
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13. In Step 1 of the Rules Wizard

dialog box for “Finish rule setup”,

enter a name for your rule.

14. In Step 2, make sure Turn on this

rule is checked.

Page 14

Rules Wizard

Finish rule setup.

Step 1: Specify a name for this rule
Bill Ramirez - Move to Folder Academyx|

Step 2: Setup rule options
[T]Run this rule now on messages already in “Inbox"

Turn on this rule

Lreate mis rule on all acoounts

Step 3: Review rule description {dick an underlined value to edit)

Apply this rule after the message arrives
from Bill Ramirez

and on this machine only
move it to the AcademyX folder

[ Cancel ][ < Back ] Next >

15. Click Finish. The Rules and Alerts dialog box will list your new rule.

Rules and Alerts

E-mail Rules | Manage Alerts

L9 |l

Li‘}ﬂew Rule... Change Rule » 53 Copy... >( Delete + % RunPRules Mow... Options

Rule (applied in the order shown)

Actions -

Y

Bill Ramirez - Move to Folder AcademyX

o I |

Clear categories on mail (recommendad)

Rule description (dick an underlined value to edit):
Apply this rule after the message arrives
from Eill Ramirez
and on this machine only
move it to the AcademyX folder

["]Enable rules on all RSS Feeds

CK H Cancel H Apply ]

16. Click OK.
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D. Creating a Rule from a Message

If you want to create a rule that will apply to messages with a particular sender
and/or subject and you have an example message, you can create the rule
directly from the message.

1. View the message. In the Ribbon, click Create Rule.

: 1 3 o] = 4 Find
1 i x R R = c@ Safe Lists~ | =H— ? ¥
-« s B L & = e || By petated -
Reply Reply Forward | Delete Movlto Create Block lot Junk Categorize Follow Mark as
to All Folde Afions = || Sender - Up~ Unread || ki Select~
Respond Junk E-mail F] Optians F] Find
2. Inthe Create Rule dialog box, | CrateRule 7|

When I get e-mail with all of the selected conditions

click the criteria and action

rom Eddie Barlow
that you want to have | momedes

[]subject contains  |Schedule UCOP Change
performed' [T]sentto | helen@nishikai.com E‘

3. Click oK. Do the following

[ Display in the Mew Item Alert window

[CPlay a selected sound: Windows Notify.wawv E E| Browse...

[ Move the item to folder: | Select Folde I Select Folder... J

QK I Cancel I I.-'-\dvanced Opt’ons...J

E. Managing Rules

e If you have several rules that might apply to one message, the rules will
be applied in the order they appear in the Rules and Alerts dialog box. For
example, if you have one rule to move a message marked Important to an
“Important Messages” folder and another rule to move a message from
Bill Ramirez to an “AcademyX” folder, a message from Bill marked as
Important will meet the criteria for both rules. The rule listed first in the
list will determine to which folder this message is moved.

e Toedit arule, go to Tools > Rules and Alerts. Select the rule and click
Change Rule - Edit Rule Settings.

e To rename a rule, go to Tools > Rules and Alerts. Select the rule and click
Change Rule © Rename Rule.

e To delete a rule, go to Tools > Rules and Alerts. Select the rule and click
Delete.

© 2008 Nishikai Consulting. All rights reserved. hn 02/2008
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Tools to File Completed Messages

Once you have handled a message, you can delete it or file it. There are several
tools that help you file and archive messages efficiently.

A. Creating Custom Folders
Custom folders let you organize messages into folders that you create. You can

create subfolders within top-level folders.

1. Right-click the Inbox in the left TR R
navigation, and select New Folder... < e >
. |
2. In the Create New Folder dialog box, —
enter the name of the new folder and click | o =nr
all an oS ms hd
Mai and Post Ite ]
OK.
. . Select where to place the folder:
e To create a subfolder within an &0
Si= ersonal Folders -
existing folder, select the folder in the 2 Calendar
. a4 c
Create New Folder dialog box before = D”tats s (1) 3
clicking OK.
7 L Inbox (12)
Journal
L@ Junk E-mail
| Motes
T2 Nutbne -
0K ] I Cancel
B. Moving a Message to a Folder
Drag the message from the Inbox to the folder in the left navigation.
e Or, right-click a message and select
Move Iterns -5 [3al
Move to Folder... In the Move Items .
Move the selected items to the folder:
dialog box, select the folder and = §5r50n3| Folders . oK
CliCk OK. fH| Calendar 7(: |
8- Contacts s
e Or, while viewing a message, click s) Deleted Items (1)  Newon
. 7| Drafts =
the Move to Folder drop-down in the -~ [ Inbox (12) i
Ribbon, and select a folder. Only :‘
(=3 Eems
top level folders are listed here. For £ uce
a subfolder, select Other Folder from 53 Journal
L@ Junk E-mail
the drop-down. ] Notes
U= Outbox &
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C. Managing Favorite Folders

If there is a folder that you need to access quickly, set it as a
Favorite Folder. These folders appear in the Favorite Folders
area above Mail Folders in the left navigation.

e Toadd a folder, right-click the folder name under Mail
Folders and select Add to Favorite Folders.

e Toremove a folder, right-click the folder name under
Favorite Folders and select Remove from Favorite Folders.

D. Using AutoArchive

In a corporate setting, e-mail messages and other items in your
Outlook account are actually kept on a Microsoft Exchange
Server. Because this data is stored in a central location, you can
check your account from any computer using an internet
browser.

However, you may be asked to archive old data periodically to
save memory space on the Exchange Server. This data will be
downloaded to the Outlook program on your primary
computer and will only be accessible from that primary
computer.

After items have been archived, you can view them in the
Archive Folder list in the left navigation.

Page 17

avorite Folders

L -] Inbox (12}
=] Sent Items (22}

|1 AcademyX y,
M F

2] Al Mail Items -

o €51 Personal Folders =
(5] Deleted Items (1)
L7 Drafts

= [~ Inbox (12)

1 AcademyX
| Test Items
3 ucs

L @ Junk E-mail

L4 Outbox

|1 Quarantine

LE]| RSS Feeds

=1 Sent Items (22}

H O Search Folders

Mail Folders

»

2] All Mail Ttems -

E] ﬁ;ﬁ Personal Folders
fa] Deleted ltems (1]
L2#| Drafts
H [ -] Inbox (12)
L gl Junk E-mail
=] Outbox
[ Quarantine
LED| R35 Feeds
I ms (22
LA Search Fo
=l = Archive Folders
@ Deleted ltems
= [d Inbox
[ AcademyX
| Test Items

3 UCE
L& Search Folde

Outlook will automatically archive old items using AutoArchive unless you
change the settings. Inbox, Calendar, Tasks, Notes, Journal, and Drafts items will
be archived after 6 months; Sent Items, Deleted Items after 2 months; and Outbox

after 3 months.
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To change AutoArchive settings:

1. Go to Tools - Options.

2. In the Other tab, click
AutoArchive...

3. Inthe AutoArchive dialog box,

select any new settings. Click OK.

AutoArchive

(-5
[¥]Run AutoArchive every |14 |- days

Prompt before AutoArchive runs
During AutoArchive:
Delete expired items {e-mail folders only)
Archive or delete old items
Show archive folder in folder list
Default folder settings for archiving

Clean out items older than | &

(@ Move old items to:
C:\Users\Helen\AppData\Local MicrosoftOutl

(") Permanently delete old items
[ Apply these settings to all folders now ]

To spedify different archive settings for any folder, right-dick
on the folder and choose Properties, then go to the
AutoArchive tab.

Retention policy

1

\\:é The network administrator has not set retention policies.

Page 18
Options |55

Preferences I Mail Setup I Mail Format I Speling | Other |

General

—p [] Empty the Deleted Items folder upon exiting
-2/ Make Qutlock the default program for E-mail, Contacts, and Calendar.
Default programs. .. ] [ Advanced Options. .. ]

Autoarchive

dhive file

L= Manages mailbox size by deleting old items or moving them to=cz
g and by deleting expired items.,

Autodrchive...

Outlook Panes

Customize options for the Outlook Panes.

Person Names

& Display online status next to a person name
Diicr Cc ds only when mouse

OK l [ Cancel Apply

e To prevent AutoArchive from
archiving a specific folder, right-click
the folder in the left navigation and
select Properties. In the Properties
dialog box, select the AutoArchive tab.
Make sure Do not archive items in this
folder is selected, then click OK.

Lo =

General | Home Page | AutoArchive | Administration | Forms

AcademyX Properties

@ Do not archive items in this folder
. ive jtems in this folder usin

Defult Archive Satbno
Letault Arcnive »etings. ..

Retention policy

s

\g The network administrator has not set retention policies.

Retention Policy Information. ..

OK ” Cancel ] Apply
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E. Using Manual Archiving
You can manually archive items instead of using AutoArchive.

1. Go to File & Archive... Archive L7 =]
. . _J Archive all folders according to their AutoArchive settings
2. Inthe Archive dialog box, select the top- P
level folder that you want to archive. Set a = €' Personal Folders -
. . . #4 Calend
date and archive file as necessary. Click S P
ontacts =
OK. @ Deleted Items (1)
3 Test lterns
) [ UCE -
Archive items older than: | Fri 2/8/2008 IE‘
[ Indude items with "Da not AutoArchive™ checked
Archive file:
C:\Jsers'\Helen\AppData\Local\Microsoft\Outlook| | Browse...
[ OK ] I Cancel I
hn 02/2008
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